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作者簡介 

 

我是建國中學三年級的王瀚德(左)，從小喜歡自然和運動，這是我的第三個專

題研究，上了高中往往從實驗室和田徑場跑來跑去，在課業、研究專題和田徑之間

strike a balance，追求卓越。不僅在台北市高中男子 1500公尺排名中展佔有一席，

更有幸參與台灣國際科展，與國內外的學生交流。 

我是建國中學三年級的王濰平(右)，我也從小喜歡自然和運動，好巧這也是我

的第三個專題研究。儘管做專題研究需要多時間，但因著在休閒活動和做研究之間

strike a balance 以及對科學的熱愛，我完成了這個研究並且很榮幸的，能夠參與在

今年的台灣國際科展。 
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摘要 

本實驗延續過去的研究，進一步探討綠豆發芽水抑制黴菌之機制。經實驗推測，綠豆發

芽水中有多種物質－而其中主要為分子量小於3kD 的胜肽參與抑制黴菌。而為更了解此現

象，設計不同的實驗探討其機制。在縮短浸泡時間後，浸泡溫度為30°C 之綠豆發芽水有抑

黴效果，未來將探討是否因綠豆階段性釋放抑黴物質導致。另外推測浸泡溫度較低時種子沒

有此機制，故在4°C 泡綠豆、黃豆、小麥。結果黃豆發芽水、小麥發芽水浸泡7天才有較明

顯的抑黴效果，未來將比較更多條件並探討此現象的原因。接著調整不同條件下的綠豆發芽

水至相同蛋白質濃度，發現30°C 泡3天180顆/120mL 的綠豆發芽水抑黴效果較差，未來將探

討是否為某些物質濃度改變導致。最後，比較不同樣本找出確切抑黴物質後，期望能應用於

臨床上。 

 

Abstract 

In this project, we take a further approach to the functions of how mung beans soaking solution 

inhibits the growth of mold. Through experiment, we found that a variety of chemicals in the 

solution tend to inhibit the growth of mold, but polypeptide chains under 3000 kilodaltons does 

most of the effort. We took different approaches to investigate functions of the mung bean soaking 

solution. After cutting short the soaking time, mung beans soaked under 30°C remains resistant to 

mold. We'll investigate if mung beans release anti-mold chemicals in stages in the future. We 

surmise that mung beans won't elicit anti-mold chemicals in low temperatures, so we soaked mung 

beans, soy beans and wheat in 4°C water. Data shows that only soy beans and wheat soaked for 7 

days are capable of releasing anti-mold chemicals. Next, after adjusting the protien concentration of 

different soaking solution variables into the same density, the set which has 180 mung beans soaked 

in 120ml water under 30°C resists mold the worst. Finally, we compare our samples to find the 

exact chemical that inhibits mold, and hopefully can be used clinical. 
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壹、研究動機 

    在參考文獻中，綠豆發芽水抑制黴菌的效果令我們感到好奇，並且想進一步的探討其抑

制機制。也讓我們聯想到此現象與第二次世界大戰時期，青黴素的發現大幅降低細菌感染而

造成的死亡率，也有異曲同工之妙。另外臨床醫生表示治療黴菌感染的藥物種類遠低於治療

細菌感染的抗生素，一旦發生抗藥性，病患的生命將受到極大的威脅。因此期望透過本實驗

研究，找到對付黴菌感染極大助益的解決方案。 

 

貳、研究目的 

一、探討在綠豆發芽水中，抑制黴菌之物質的分子量範圍為何 

二、探討在綠豆發芽水中，何種物質具有抑制黴菌生長的效果 

三、綠豆在釋放不同的抑制黴菌物質時，是否為階段性釋放 

四、尋找不同條件下的的綠豆或是其他種子的發芽水，比較抑制黴菌效果之差異 

五、透過二維電泳分析樣本尋找可能抑制黴菌的蛋白質，並予以鑑定蛋白質的種類 

 

參、研究設備及器材 

一、研究器材 

量筒、血清瓶、錐形瓶、蛋白質濃縮管、石臘膜、滴管、吸量管、離心管、刮勺、微量

吸量管、培養皿、鋁箔紙、滅菌膠帶、布丁杯、離心瓶、鑄膠套件。 

二、研究設備 

電磁加熱攪拌器、離心機、電鍋、振盪器、RO 水供應器、電泳槽、電源供應器、等電

點電泳儀、光譜儀、高溫高壓滅菌鍋、恆溫培養箱、酵素免疫分析儀、吸量管輔助器、電子

分析天平、相機、電腦、4°C 冰箱、-20°C 的冷凍庫。 

三、研究材料 

75%酒精、螯合劑、活性碳、吐司、綠豆、黃豆、小麥、丙酮 



3 

 

肆、研究過程或方法 

一、研究架構示意圖 

 

 

 

 

 

註： kD,kilodalton,分子質量單位 

  CO, cut off 的縮寫 
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二、參考資料的實驗結果 

（一）當綠豆浸泡溫度為25°C 時，抑黴效果最好的狀況是泡4天120顆，30°C 是泡3天180

顆，35°C 則是泡2天120顆。 

（二）綠豆發芽水中有多種蛋白質會抑制黴菌生長，其中主要的抑黴物質的分子量在30 

kD~50 kD 之間，而其他可能分子量範圍為50 kD~100 kD。 

（三）另外，還有可能有分子量較小的有機物質也會抑制黴菌生長。 

三、研究方法 

（一）基本實驗操作方式 

1. 浸泡 

（1）RO 水予以滅菌，布丁杯與量筒用酒精擦拭消毒。 

（2）布丁杯裡倒入定量的豆子與滅菌水後用石臘膜封住，置於4°C 冰箱、室溫

（約22°C~23°C）或 30°C 恆溫培養箱中。 

2. 生長 

（1）將一片吐司麵包切成四等分，再用電鍋蒸30分鐘滅菌後，快速的放入培養

皿中。 

（2）取出10ml 的溶液倒在吐司上，使其完全被吐司吸收，並點上五點黴菌

（Aspergillus Niger）。 

3. 紀錄 

（1）將吐司放於恆溫培養箱中，每天拍照觀察記錄。 

（2）將圖片整理好後，計算覆蓋率，進行比較。 

（二）綠豆發芽水的不同處理方式 

1. 加入螯合劑 

在綠豆發芽水中加入螯合劑使溶液濃度呈2mM 後，搖晃均勻。 

2. 煮沸 

（1）把綠豆發芽水倒入錐形瓶後利用電磁加熱攪拌器加熱，使其沸騰兩分鐘

後，立即放入冰塊中冷卻。 
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（2）用無菌水補回蒸發掉的量，以保持相同濃度。。 

3. 加入活性碳 

（1）在每10ml 的綠豆發芽水中加入0.15g 的活性碳。 

（2）以振盪器使其混合均勻並充分反應後，離心去除活性碳。 

4. 使用蛋白質濃縮管過濾 

（1）把綠豆發芽水加入蛋白質濃縮管中，其濃縮的 cut off 分別為分子量 3、

10、30、50、以及100 kD 

（2）離心過濾使分子量小於 cut off 的物質通過半透膜。 

（三）浸泡顆數 

1. 在探討分子量以及不同處理方式的實驗中為120顆綠豆/120mL。 

2. 尋找比較樣本時，綠豆一樣是120顆/120mL，黃豆是90顆/120mL，小麥則是300

顆/120mL。 

3. 在探討綠豆是否為階段性釋放抑黴物質時，我們以180顆/120mL 浸泡綠豆。 

（四）計算黴菌覆蓋率 

1. 使用 ImageJ 打開圖片之後，把圖片多餘的部份裁除（Image -> Crop）。 

2. 從 Image -> Adjust -> Color Threshold，透過顏色、飽和度以及亮度選取範圍。 

3. 選取好後至 Analyze -> Measure 測量選取範圍的像素量，之後再以黴菌覆蓋範

圍的像素量除以吐司所占的像素量即為覆蓋率。 

圖一：使用 ImageJ 計算覆蓋率之情形 
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（五）冷凍乾燥黴菌之活化 

1. 活化菌種：Aspergillus niger。 

2. 在無菌的環境之下，用火將外玻璃管燒熱後輕輕敲破，接著用鑷子夾出隔開空

氣的紙捲。 

3. 取0.5ml 無菌水加入內管，並輕輕搖晃使其均勻懸浮。 

4. 將菌液0.1-0.2ml 塗於 Potato Dextrose Agar（PDA）培養基上養殖。 

（六）丙酮蛋白質沉澱 

1. 取50ml 實驗樣本倒入250ml 離心瓶中，以6000g 離心10分鐘。 

2. 倒出上清液，清掉離心瓶中的雜質片後取49ml 上清液倒回離心瓶，並加入

49*5ml 的丙酮，再放入-20°C 的冷凍庫中冷卻20~30min.。 

3. 以10000rpm 離心10min.後，小心將上清液倒掉，再用水小心把多餘的丙酮洗

掉，加入5ml 去離子水回溶蛋白質。 

（七）等電點電泳 

1. 為確保 Strip holder 的潔淨，先以 IPGphor holder cleaning solution 清洗乾淨。 

2.  調整 tray 的水平。 

3. 將 rehydration solution 與樣本混合後放入 tray 中；或者先不加入樣本，代

rehydration 時間結束後再加入。 

4. 將膠條上的膜從 pH 值低的地方移除。 

5. 將膠面朝下放入膠條至 holder 中。 

6. 注意勿留下氣泡並於上方覆蓋約3 ml 的 Drystrip cover fluid 至完全覆蓋住膠條。 

7. 覆蓋蓋子即可。 

8. 放入兩張已剪裁成適當大小的濾紙，以二次水浸濕，再以濾紙吸乾多餘的水

後，將濾紙放入電極處。 

9. 加 Cup-loading strip holder 蓋子，並放上等電點電泳儀即可依樣本種類決定樣本

的電泳流程。 
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（八）SDS PAGE（12%）蛋白質電泳實驗 

1. 取鑄膠套件組裝之後，拿50 ml 的離心管，加入以下的物質：（順序由上而下） 

表一：配製一片下膠的配方(mL) 

H2O 4.3 

Bis acrylamide mix 40% 3 

1.5M Tris pH8.8 2.5 

SDS 25% 0.1 

APS 0.1 

TEMED 0.008 

2.把膠注入到2/3或3/4。在上面再加一層酒精或異丙醇，進行壓膠，等待30分鐘使

其凝固。 

3. 在等待下膠凝固的時候配置上膠（堆疊層）。取50 ml 的離心管，加入以下的物

質：（順序由上而下） 

表二：配製一片上膠的配方(mL) 

5% 免配置溶液 4 

APS 0.04 

TEMED 0.004 

4. 把酒精倒掉後，鑄滿上膠，接著插上樣本書。靜待20分鐘凝固。 

5. 從鑄膠器取下玻璃片之後，把底部多餘的膠沖乾淨。 

6. 將膠片架到電泳槽上，並把稀釋成一倍的通用電泳緩衝液，倒入電泳槽的底

部，而兩片膠之間倒入 SDS running buffer 之後接上電源開始電泳。 
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（九）膠體染色  

1. 用 staining solution（表3）染色3小時或至隔夜。 

2. 之後將膠體置於 Destain solution I（表4）中退染1小時。 

3. 再用 Destain solution II（表5）清洗膠體至隔夜。 

表三：銀染藥品試劑表 

 

 

表四：Destain solution I 藥品試劑濃度表 

Methanol 40% 

Acetic acid 10% 

 

表五：Destain solution II 藥品試劑濃度表 

Methanol 5% 

Acetic acid 7% 
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（十）測量蛋白質濃度（BCA） 

1. 取樣本以及0、0.2、0.4、0.8、1.2、1.6 mg/mL BCA 的標準液各10μL 加入96 

well plate 裡，且每個都要三重複。 

2. 配 BCA => Reagent A：Reagent B = 50：1，每個 well 注入200μL。 

3. 留3個 well 只放 BCA 當作 blank。 

4. 在恆溫培養箱反應30分鐘後，放入酵素免疫分析儀，以562nm 的光測量樣本吸

光值後，與標準液比較並計算蛋白質濃度。 

 

伍、研究結果 

一、探討綠豆發芽水中有無雜質對抑黴的影響 

雜質通常為分子量較大的物質，在使用蛋白質濃縮管過濾時，很容易使濃縮管中的半

透膜堵住，影響過濾的效果。為了避免去掉雜質後會影響綠豆發芽水抑制黴菌的效果，因此

進行實驗比較去掉雜質後綠豆發芽水抑黴效果的差異。圖二為有無去雜質的綠豆發芽水之黴

菌覆蓋率比較圖（數據請見附錄表六）。 

圖二：有無去雜質的綠豆發芽水之黴菌覆蓋率比較圖 

    結果顯示去掉雜質並不會影響綠豆發芽水抑制黴菌的效果，因此為了便於實驗進行，之

後的實驗皆會去掉溶液中的雜質。 
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二、探討在綠豆發芽水中，抑制黴菌之物質的分子量範圍為何 

    因為此篇研究使用的菌種不同於參考資料，因此想確認主要抑制黴菌之物質的分子量範

圍。圖三為不同分子量範圍的綠豆發芽水之黴菌覆蓋率比較圖（數據請見附錄表七）。 

圖三：不同分子量範圍的綠豆發芽水之黴菌覆蓋率比較圖 

    結果顯示當 cut off 為3kD 時綠豆發芽水有顯著抑制黴菌的效果，可見主要抑制黴菌的物

質分子量約在3kD 以下。而當 cut off 為其他數值時黴菌覆蓋率有些微差異，但 cut off 為

100kD 時，大部分的物質皆通過了半透膜，抑制黴菌的效果依然不如未處理之綠豆發芽水。

因此推測是因為這個機制很複雜，可能會有各種不同的物質影響，而有一個分子量在100kD

以上物質的會使綠豆發芽水抑制黴菌的效果變好。
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三、探討在綠豆發芽水中，何種物質具有抑制黴菌生長的效果 

（一）以參考資料中的處理方法，確認主要抑制黴菌之物質為何。 

圖四為不同方式處理的綠豆發芽水之黴菌覆蓋率比較圖（一）（數據請見附錄表八）。 

圖四：不同方式處理的綠豆發芽水之黴菌覆蓋率比較圖（一） 

    此實驗結果與參考資料相符，加入螯合劑使金屬離子無法與其他物質反應並不會影響抑

黴效果。而煮沸後會使蛋白質變性、加入活性碳會吸附分子量較小的有機物質。經過這兩種

處理方法後的綠豆發芽水失去了抑制黴菌的效果，可得知蛋白質以及分子量較小的有機物質

有參與這個機制。 
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（二）結合探討分子量範圍以及不同處理方式的結果 

    因為在探討分子量範圍的實驗中，推測主要抑制黴菌的物質可能為分子量在3kD 以

下的物質，而在經過煮沸後的綠豆發芽水也會失去些抑制黴菌的效果。因此把經過 cut 

off 為3kD 的蛋白質濃縮管處理後的綠豆發芽水煮沸，進行比較。圖五為不同方式處理過

的綠豆發芽水之黴菌覆蓋率比較圖（二）（數據請見附錄表九）。 

圖五：不同方式處理過的綠豆發芽水之黴菌覆蓋率比較圖（二） 

    把經過 cut off 為3kD 的蛋白質濃縮管處理後的綠豆發芽水煮沸後，失去了抑制黴菌的效

果，因此我們推測分子量小餘3Kd 的胜肽為主要抑制黴菌的物質。 
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四、綠豆在釋放不同的抑制黴菌物質時，是否為階段性釋放 

    經過之前的實驗後，推測這個抑制黴菌的機制十分複雜，可能有多種不同的物質參與反

應。由於不確定綠豆是否為同時釋放這些抑制黴菌的物質，還是階段性釋放，因此做了這個

初步的實驗。圖六為在室溫時浸泡較短時間的綠豆發芽水之黴菌覆蓋率比較圖、圖七為在

30°C 時浸泡較短時間的綠豆發芽水之黴菌覆蓋率比較圖（數據請見附錄表十、十一）。 

圖六：在室溫時浸泡較短時間的綠豆發芽水之黴菌覆蓋率比較圖 

圖七：在30°C 時浸泡較短時間的綠豆發芽水之黴菌覆蓋率比較圖 

    當浸泡溫度為室溫時，浸泡時間在1天之內的綠豆發芽水都沒有抑制黴菌的效果，可能

是還沒開始釋放抑黴物質或濃度太低。而在30°C 時，當浸泡到6小時即有抑制黴菌的效果，

且效果越來越好。可見當溫度夠高時，就算浸泡時間較短，綠豆發芽水依然有抑制黴菌的效

果。之後會再針對此結果，繼續實驗探討。 
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五、尋找不同條件下的的綠豆或是其他種子的發芽水，比較抑制黴菌效果之差異 

（一）在4°C 時浸泡綠豆、黃豆、小麥比較發芽水差異 

    為了找到沒有抑制效果的樣本，跟有抑制黴菌效果的綠豆發芽水比較差異，於是選

了其他種子進行比較。並且因為黴菌適合的生長溫度為20°C~30°C，因此想嘗試在溫度

較低的狀況下，種子是否不需要有抑制黴菌的機制，而不會釋放抑制黴菌的物質，所以

選擇4°C 作為浸泡溫度。至於種子的選擇，有鑒於黃豆以及小麥得生長溫度較低，可能

不會有抑制黴菌生長的機制，因此選取這兩個種子進行比較。圖八為4°C 泡3天時不同的

種子發芽水之黴菌覆蓋率比較圖、圖九為4°C 泡7天時不同的種子發芽水之黴菌覆蓋率比

較圖（數據見附錄表十二、十三）。 

圖八：4°C 泡3天時不同的種子發芽水之黴菌覆蓋率比較圖 

圖九：4°C 泡7天時不同的種子發芽水之黴菌覆蓋率比較圖 
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    在4°C 浸泡綠豆時，無論泡3天還是7天皆有明顯的抑黴效果，但是黃豆水和小麥水

則是在浸泡7天才有較明顯的效果。之後會再探討是否在3~7天中黃豆以及小麥是否有什

麼關鍵的物質釋放，或者也可以經過二維電泳比較後排除一些蛋白質。另外，也會使用

更多種子進行比較、分析。 

 

（二）把不同條件下的綠豆發芽水調成蛋白質濃度相同後比較差異 

    推測在不同的條件下，綠豆發芽時釋放的物質種類以及比例會不相同。再加上之前

的實驗中蛋白質可能為主要抑制黴菌的物質，因此嘗試把不同的條件下的綠豆發芽水調

整成具有相同蛋白質濃度後，比較抑制黴菌的效果。圖十為不同條件下的綠豆發芽水調

至相同蛋白質濃度後之黴菌覆蓋率比較圖（數據請見附錄表十四、十五）。 

圖十：不同條件下的綠豆發芽水調至相同蛋白質濃度後之黴菌覆蓋率比較圖 

    在調整蛋白質濃度後，在30°C 時泡3天180顆/120mL 的黴菌覆蓋率較高。未來將著

手進行蛋白質二維電泳，比較不同條件下相異點的差異。 
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六、透過二維電泳分析樣本尋找可能抑制黴菌的蛋白質，並予以鑑定蛋白質的種類 

圖十一：綠豆發芽水進行二維電泳之結果圖 

目前已經以未處理之綠豆發芽水進行二維電泳，待欲比較之樣本確定後會一同進行二維

電泳比較。 

 

陸、討論 

一、溫度對於實驗的影響 

（一）以黴菌生長時的溫度而言，根據參考資料，最適合黴菌生長的溫度為20°C~30°C

之間。經過我們的實驗之後，當溫度為20°C 時黴菌生長緩慢，很難看出黴菌生長

的差距；而當溫度為25°C 時，已經可以觀察到綠豆發芽水抑制黴菌的效果；但是

當溫度30°C 時，倒入無菌水和綠豆發芽水的吐司上的黴菌覆蓋範圍有顯著差異。

因此，我們選用30°C 作為實驗時黴菌生長的溫度，以便於實驗的觀察及數據統

計。 

（二）至於浸泡綠豆時的溫度，在一開始的實驗時，先是在30°C 的狀況下進行。但是在

經過好幾次的實驗後，發現實驗結果不如預期，所以試著改成放在室溫（約
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22°C~23°C）浸泡。而在經過幾次實驗之後，實驗結果變得比較一致，所以選用室

溫（約22°C~23°C）作為綠豆浸泡時的溫度。由此推測這個結果是當溫度為30°C

時，酵素的活性較高，很有可能有非專一性的反應產生，導致實驗結果的不穩定。 

（三）另外最近發現，雖然黴菌是放在恆溫培養箱內生長，但是放的位置依然會影響實

驗結果。由於做實驗時需要三重複，因此會把三個培養皿疊成一疊後放入恆溫培養

箱，但是每次最下面那個培養皿中的黴菌都會長得特別多，不利於實驗的數據統

計。推測是因為最下面的培養皿會直接接觸到恆溫培養箱中的鐵架，而鐵架具有良

好導熱效果，會使最下面的培養皿獲得較多的熱能，再加上黴菌對溫度的靈敏度很

高，因此生長得較佳。為了改善這個狀況，會在三個實驗的培樣皿下再放一個培養

皿，防止鐵架直接導熱至實驗樣本，而經過這個步驟後，改善了這個現象。 

二、有時煮沸後的綠豆發芽水依舊有抑制黴菌的效果的原因 

（一）前期的實驗中，是把綠豆水煮沸5分鐘後留在電磁加熱攪拌器上放涼。而此時電磁

加熱攪拌器只是關掉電源而已，尚有餘溫，因此實際上綠豆發芽水沸騰的時間不只

5分鐘。在沸騰這麼久後，推測綠豆發芽水有些微燒焦的情況，而這燒焦的物質很

有可能也會抑制黴菌生長。因此為了避免綠豆發芽水煮沸太久而導致燒焦，在之後

的實驗中改為只沸騰2分鐘。 

（二）另外，可能有些蛋白質雖然在煮沸的過程中結構已經被破壞，但在放涼時又慢慢

恢復了原本的結構，因此還保有些許的功能。為了避免這狀況，在綠豆發芽水沸騰

2分鐘後立即放入冰塊中降溫，使蛋白質無法恢復原本的結構。而在經過這兩方面

的改善後，沸騰後的綠豆發芽水即失去了抑制黴菌的效果。 

三、排除為農藥在抑制黴菌生長的原因 

（一）本實驗中選用的綠豆為大賣場內所販售的一家大品牌公司所推出的產品，並且有

通過 HACCP、ISO 22000等認證，幾乎不會有農藥殘留，所以農藥應該不會是造成

抑制黴菌生長效果的主因。 

（二）目前在種植綠豆的過程中，使用的農藥通常為殺蟲劑，如歐殺松、達馬松等，並

不會有抑制黴菌的效果。 
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（三）如果是殘留在綠豆上的農藥抑制黴菌的話，照裡來說只要把綠豆浸泡一陣子，農

藥就會從綠豆表皮上進入水中。但是在室溫時浸泡3hr.~24hr.的綠豆發芽水並沒有

抑制黴菌的效果，可見就算有殘留的農藥在抑制黴菌，也只是本實驗所觀察到的抑

制效果中的冰山一角，並非主要原因。 

四、Cut off 的實驗和參考資料結果不一致的原因 

    參考資料所採用的黴菌為空氣接種後分離的一種青黴菌，跟本次的黑黴菌（Aspergillus 

Niger）並非相同的菌種。可能是綠豆發芽水中有多種抑制黴菌生長的物質，只是在面對不

同的黴菌時，主要抑制黴菌的物質並不一樣。 

 

柒、結論 

一、綠豆發芽水中有不只一種物質參與抑制黴菌，推測最主要的物質可能是分子量小於3kD

的胜肽，並且有分子量大於100kD 的物質也會參與抑制黴菌的機制。 

二、當浸泡溫度為30°C 時，就算浸泡較少時間的綠豆發芽水依然有抑制黴菌的效果，且隨

著浸泡時間增加而效果變好。 

三、當浸泡溫度為4°C 時，浸泡3、7天的綠豆發芽水皆有抑制黴菌的效果，但是黃豆發芽

水、小麥發芽水在浸泡7天時才有較明顯的抑黴效果。 

四、不同條件處理的綠豆發芽水調整至具有相同的蛋白質濃度下，發現30°C 泡3天 

180顆/120mL 的綠豆發芽水黴菌覆蓋率較高。 

 

捌、未來展望 

一、比較更多不同的種子發芽水在不同溫度時抑制黴菌的效果，尋找沒有抑制黴菌效果的對

照組，跑二維電泳進行比較。 

二、進一步探討當浸泡溫度為30°C 時浸泡較短時間的綠豆發芽水，在浸泡時間增加時抑制

黴菌效果也增加的原因，是因為某個抑黴物質或者整體抑黴物質的濃度變高，還是綠豆

陸續釋放抑黴物質而造成。 
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三、進一步探討在蛋白質濃度調整一致後，30°C 時泡3天180顆/120mL 的綠豆發芽水黴菌覆

蓋率較高，是否是因為某些物質的的濃度改變而導致。 

四、已經和長庚蛋白質體實驗中心聯絡，在經過二維電泳比較找到感興趣之蛋白質或寡胜肽

後，使用質譜儀鑑定分析。 
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20 

 

拾、附錄 

表六：有無去雜質之綠豆發芽水抑制黴菌效果比較表 

        操縱變因 

三重複 
無菌水 

有雜質之 

綠豆水 

去雜質之 

綠豆水 

1 78.43% 9.62% 13.74% 

2 82.15% 9.47% 12.61% 

3 83.73% 21.56% 21.93% 

平均 81.44% 13.55% 16.10% 

 

表七：不同分子量範圍的綠豆發芽水之黴菌覆蓋率比較表 

      操縱變因 

三重複 

無菌水 
未處理 

綠豆水 
CO3kD CO10kD CO30kD CO50kD CO100kD 

1 88.34% 22.50% 43.02% 25.47% 21.89% 49.46% 52.02% 

2 75.49% 31.22% 32.31% 41.86% 56.65% 47.19% 50.70% 

3 87.16% 52.70% 61.83% 59.91% 72.95% 53.34% 74.14% 

4 74.83% 

3.73% 

(腐爛) 
32.27% 20.23% 23.62% 14.11% 33.19% 

5 60.97% 
8.39% 

(腐爛) 
30.72% 29.39% 19.50% 13.67% 27.41% 

6 79.35% 
11.24% 

(腐爛) 
41.06% 64.99% 62.63% 44.54% 80.58% 

平均 77.69% 26.86% 35.88% 29.19% 30.42% 35.44% 40.83% 

註：編號 1-3、編號 4-6 分別為兩組數據 
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表八：不同方式處理的綠豆發芽水之黴菌覆蓋率比較表（一） 

        操縱變因 

三重複 

無菌水 
未處理之 

綠豆水 
加入 EDTA 煮沸 加入活性碳 

1 54.16% 9.47% 16.30% 48.19% 55.61% 

2 50.92% 9.30% 16.87% 65.10% 66.12% 

3 85.38% 14.13% 56.02% 68.36% 70.58% 

平均 52.54% 10.97% 16.58% 60.55% 64.10% 

 

表九：不同方式處理的綠豆發芽水之黴菌覆蓋率比較表（二） 

操縱變因 

三重複 

無菌水 
未處理之 

綠豆水 

一般綠豆水 

煮沸 

CO3kD 

煮沸 

1 43.51% 4.53% 44.56% 46.70% 

2 33.51% 3.25% 45.65% 55.49% 

3 65.91% 3.30% 69.89% 56.79% 

平均 38.51% 3.70% 45.11% 53.00% 

表十：在室溫時浸泡較短時間的綠豆發芽水之黴菌覆蓋率比較表 

        操縱變因 

三重複 

無菌水 3hr. 6hr. 9hr. 12hr. 18hr. 24hr. 

1 75.97% 54.11% 83.57% 
30.39% 

(腐爛) 
72.33% 78.60% 73.18% 

2 73.88% 66.28% 74.70% 
17.98% 

(腐爛) 
62.13% 58.75% 88.14% 

3 68.65% 60.44% 57.04% 
20.30% 

(腐爛) 
52.70% 60.64% 54.22% 

平均 72.83% 60.28% 71.77% 22.89% 62.39% 66.00% 80.66% 
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表十一：在30°C 時浸泡較短時間的綠豆發芽水之黴菌覆蓋率比較表 

        操縱變因 

三重複 

無菌水 3hr. 6hr. 9hr. 12hr. 18hr. 24hr. 

1 60.83% 56.81% 32.44% 22.74% 30.85% 9.88% 26.67% 

2 77.79% 77.28% 57.32% 67.25% 24.58% 22.13% 31.85% 

3 88.26% 86.49% 90.21% 68.03% 60.58% 37.15% 44.02% 

平均 83.03% 81.88% 73.76% 67.64% 27.71% 29.64% 34.18% 

 

表十二：4°C 泡3天時不同的種子發芽水之黴菌覆蓋率比較表 

        操縱變因 

三重複 

無菌水 綠豆水 黃豆水 小麥水 

1 91.56% 37.12% 55.22% 86.17% 

2 90.32% 35.50% 72.20% 68.78% 

3 90.32% 32.36% 53.49% 90.27% 

平均 90.73% 34.99% 60.30% 81.74% 

 

表十三：4°C 泡7天時不同的種子發芽水之黴菌覆蓋率比較表 

        操縱變因 

三重複 

無菌水 綠豆水 黃豆水 小麥水 

1 76.15% 45.76% 26.41% 27.99% 

2 65.55% 43.47% 33.85% 47.38% 

3 69.42% 56.27% 70.14% 51.89% 

平均 70.37% 48.50% 30.13% 42.42% 
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表十四：不同條件下的綠豆發芽水之分析 

 

泡3天 180顆/120mL 泡4天 120顆/120mL 

室溫 30°C 室溫 30°C 

稀釋5倍

的吸光值 

1 0.3140 0.3764 0.2988 0.3135 

2 0.3282 0.3608 0.2920 0.2978 

3 0.3282 0.3876 0.2884 0.2788 

平均 0.3235 0.3749 0.2931 0.2967 

蛋白質濃度（mg/mL） 3.6823 4.5627 3.1623 3.2244 

調整至 

同濃度 

樣本（mL） 30.1 24.3 35.0 34.3 

無菌水

（mL） 
4.9 10.7 0.0 0.7 

 

表十五：不同條件下的綠豆發芽水調至相同蛋白質濃度後之黴菌覆蓋率比較表 

     操縱變因 

三重複 

無菌水 

泡3天 180顆/120mL 泡4天 120顆/120mL 

室溫 30°C 室溫 30°C 

1 90.66% 22.29% 40.79% 7.55% 19.58% 

2 88.28% 24.78% 57.32% 22.90% 27.92% 

3 94.34% 18.82% 72.74% 25.21% 68.59% 

平均 91.09% 21.96% 56.95% 18.55% 23.75% 

 

註：表格中畫斜線的數據為極值不採計 

    吐司腐爛會影響黴菌生長也不採計 

 



【評語】060007 

有關本研究，建議如下： 

1. 研究之題目有趣、獨特、有原創性。 

2. 英文簡介及對答十分清楚，表現佳。 

3. 有系統的實驗設計及數據，結果具有再現性。 

4. 數據可以證明結論，但仍然不能排除不耐熱非多胜肽的小分子

有參與抑制黴菌之作用。 

5. 建議以 LC-MS分析可能作用的小分子。 
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